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Using the Internet

The Internet is a global network of computers linked together by phone lines that
enables information to be exchanged between computers anywhere in the world.

Access to information on the Internet can be gained using Netscape Communicator.
Netscape Communicator is browser software which allows you to search and retrieve
information. Information can be in various forms, text, graphics, audio and video files.
Audio and video files can only be downloaded if your computer is capable of handling
these files.

Loading Netscape
Selecting the Netscape Communicator icon with the mouse and double
clicking on it will load the program. The home page for the Institute of
Education is loaded first.

The World Wide Web can be described as the multimedia section of the Internet as it
gives you pictures and sounds in addition to a vast array of textual information. It
makes information available in Hypertext format. Each page has hypertext links to
other related pages. The links are the sections of text which are underlined and in
colour, usually blue. Links may also be assigned to graphics. Clicking on these sections
activates the link to the page.

Toolbar Buttons
Activate Netscape
features most
commonly used
e.g.
go back to previous
page, reload page,
go to home page,
print

Hypertext links
Clicking on these links will
take you to another page

Status bar
Gives information
on the progress of
your request

Web site address
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You can identify whether text or a
graphic is a link by hovering your
mouse over the text and looking for
the hand symbol.

Accessing Other Pages

To access other pages there are 2 options:

1. Use a Search Engine
2. Enter the unique reference for the location of the information

1. Using a Search Engine

A search engine is a service on the Web that helps you find what you are looking for.
You provide key words and the search engine comes up with a list of Web sites that
contain them.

One way of loading a search engine is to click on the Search button on Netscape's
toolbar and a new page will load which provides a space for you to type in the Keyword
or group of keywords for your search.

The outcome of a search can be overwhelming as it can provide many thousand web
sites as a result of the search. There are ways of narrowing your search. You can
access information on how to do this by clicking on the Search Tips link. There is a
useful summary of search engines and the methods used to narrow your search for
each at the end of this document.

Each search engine may provide different results so is worth trying more than one and
comparing results.

2. Entering the unique reference for the location of the information

Each web page has a unique address for its location. These addresses are sometimes
referred to as URLs which stands for Uniform Resource Locator.

The Search Tips link
will take you to a
page leading to
useful tips for
entering keywords as
the search criteria for
various different
search engines
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For example http://www.ncet.org.uk will open the National Council for Educational
Technology (NCET) home page.

You can either type the address for a location in the Location window at the top of any
web page and then press the Return key on your keyboard

Or,

You can select Open Page from the File menu to call up the following dialogue box:
(The shortcut for this is to press CONT + O on the keyboard)

Type in the URL or address you require and then click the Open button.

Either method will initiate the browser to attempt to make a connection to your chosen
location. The connection may be made in seconds or it may take up to a few minutes.
The length of time that a page takes to load depends on where it is coming from and
the content of the page. Mainly text loads faster than a page which is mostly graphics.
The Status bar at the bottom of the screen gives information on the progress of the
transfer of data. A page with graphics will take longer to load. The text will load first
followed by the graphics. It is possible to click on a hypertext link and move to the next
page before the graphics are fully loaded

When attempting to make a connection to a location an error message may appear.

This indicates that the server issuing
the page may be temporarily shut
down or too busy with other
connections to handle your request.
It is always worth trying again but
make sure the address is correct if
you have entered the location
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Back/Forward/Home
Clicking on the links within each page, either underlined text or
graphic links will load further pages of information. You can navigate
back to previous pages and then forward again to the present page
using the Back and Forward buttons on the toolbar.

Clicking on the Home button on the toolbar will always take you back to the
Institute of Education Home Page.

Bookmarks

Pages which you have found useful can have their locations saved as a bookmark.
These pages can then be subsequently loaded from the bookmark, this is useful when
you have found information by progressing through many links between pages.

To bookmark a page click on the Bookmark button on the
toolbar or select Bookmark from the Communicator menu.

The following dropdown menu will appear:

Add Bookmark
will add the current web page to the list of
bookmarks

File Bookmark
will give you the chance to file away the new
bookmark in a folder which you have previously
created

Edit Bookmark
will give you the chance to edit any of the
bookmarks or create bookmark folders

Using Go

Go is a useful facility as it gives you a
history of the pages already loaded as a
list. It is then possible to revisit a page by
selecting from the list without retracing
your way back through all the links.

To use, click on Go in the menu bar and
select which location you wish to go to
next.
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Printing

An option to print pages is available in Netscape. However you may find that some
information will print successfully while others pages will not. This depends on the
capability of the printer to handle commands from the Netscape software.

Print by either selecting Print button on the toolbar or by selecting Print from the File
menu. The latter method will give you the chance to select how many pages you wish
to print.

Saving Text Files

Pages can be saved as text files which can then be opened by word processing
programs and be printed or edited.

Only the text on the page is saved, any other media on the page is not saved.
Click on the Save as command from the File menu. Select Plain Text (*.txt) from the
Save File as Type option and then enter a filename, including the .txt extension. The
file can be saved as the default type Source (*.htm) but this will display Hypertext
codes when loaded into a word processing program. The saved .htm file can be loaded
in Netscape using the Open File command in the File menu. Information can then be
looked at off-line which can be a cheaper option, particularly at home or in schools.

Copying Text
Hold down the mouse button in the content area and drag to select portions of text.
Then select Copy from the Edit menu to copy this selection to the clipboard. The
copied section can be pasted from the clipboard into a word processing file.

Saving Graphic Files

Graphics files can be saved in jpeg (only using Internet Explorer) or gif formats to any
drive or a floppy disk. These are standard formats for digitised images and the file
format used to store the image will be given when you save the file. Once saved to a
drive the graphic file can then be opened in a graphics program or inserted into a word
processing or desktop publishing file.

To save a graphic :

•  move the mouse pointer inside the graphics
image area.

•  right-click the graphic and the following shortcut
menu will appear:

•  Select Save Image As
•  In the Save As dialogue box select the location

you wish to save the file to and change the
name of the file if necessary.
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Saving Video Clips

Video clips can be saved as avi, mov mpeg or files. To show graphics or play video
clips you need to use software such as Quicktime which includes Picture Viewer and
Movie Player or they can be assembled in a multimedia presentation using a program
such as HyperStudio.

Useful Internet Pages for Education

NCET:  (National Council for Educational Technology) is involved in a number of
projects which aim to encourage the use of Information and Communications
Technology in education. Their home page is located at
http://www.ncet.org.uk

NCET: NCET's Internet publication Highways for Learning: the Internet for schools and
colleges is written for classroom teachers and managers in schools and colleges. It is
available in text form on the Web.
http://www.ncet.org.uk/publications/highways/

DfEE: The Department for Education and Employment has a comprehensive web site
with all the latest government education papers, which can be downloaded.
http://www.dfee.gov.uk

BECTa: British Educational Communications and Technology Agency. This site
includes a wide range of ICT information, projects and resources. There is also access
to the National Grid For Learning (NGFL) and the Virtual Teachers Centre.
http://www.becta.org.uk

OFSTED: The government inspection body site where all school inspection reports are
published. This is useful for researching placement schools or potential employers.
http://www.ofsted.gov.uk

NGFL: This recent Government initiative aims to have all schools connected to the
Internet by 2002, thereby creating a National Grid for Learning. This web site is a
collection of resources brought together by the Government.
http://www.ngfl.gov.uk

BBC: This is a useful internet starting point as there is a list of useful sites and links for
each subject. A short description is given so you have a flavour of what might be
available. Use the BBC Bitesize revision site to test your own GCSE subject
knowledge!
http://www.bbc.co.uk/education

The Institute of Education: Information about courses, facilities and help for students
is on our web site.
http://www.ioe.co.uk

http://www.ncet.org.uk/publications/highways/
http://www.ncet.org.uk/publications/highways/
http://www.dfee.gov.uk/
http://www.becta.org.uk/
http://www.ofsted.gov.uk/
http://www.ngfl.gov.uk/
http://www.bbc.co.uk/education
http://www.ioe.co.uk/
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PGCE Support: There is a Web site within the Institute site specifically for PGCE
Students.
http://www.ioe.ac.uk/ics/pgceictresources

TTA: This site gives information about all recent Teacher Training Agency initiatives,
policies and documents.
http://www.teach-tta.gov.uk

Campus World: Communications projects and on-line resources for education
http://www.campus.bt.com

Schools Online: Project to support the development of curriculum materials in Science
and Languages
http://sol.ultralab.anglia.ac.uk/pages/schools_online/

Media Site:  Provides access to International newspapers, magazines and broadcast
material.
http://www.potter.net/mediasite

Research Machines: This site has RM’s Internet for Learning pages which provide
thousands of links for a wide range of curriculum topics. Most of the information is only
available to subscribers to RM’s service. The Eduweb section provides links to UK
schools who have Web pages. Links to many other educational organisations and
professional bodies are also provided as well as a classroom forum for teachers
http://www.rmplc.co.uk

TONIC The Online Netskills Interactive Course
To take you further you can access an on-line structured course on using the Internet
which has been developed for UK higher education at
http://www.netskilss.ac.uk/TONIC

http://www.ioe.ac.uk/ics/pgceictresources
http://www.teach-tta.gov.uk/
http://www.campus.bt.com/
http://sol.ultralab.anglia.ac.uk/pages/schools_online/
http://www.potter.net/mediasite
http://www.rmplc.co.uk/
http://www.netskilss.ac.uk/TONIC
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Search Engine Summary
Try searching for a topic using at least three different search engines and
compare your results.

www.itrc.ucf.edu/conferences/pres/srchtool.html
Thanks to :
SEIR*TEC for this very useful table from their webpage

http://www.itrc.ucf.edu/conferences/pres/srchtool.html
http://www.itrc.ucf.edu/conferences/pres/srchtool.html
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